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Introduction 
 
MetaCore contains many options for network building and manipulation.  This manual 
will go through those options in addition to describing other advanced features of 
MetaCore such as gene list export and experiment sharing. 
 
Network Building 
 
Algorithms 
 
MetaCore has four “Analyze” network algorithms.  These algorithms are good to use 
when you have a large number of network objects.  They all result in a list of smaller 
networks, ranked by a p-Value, which can be built separately.  Analyze network creates a 
large network and breaks it up into smaller sub-networks which can be built separately.  
The resulting networks are ranked by a p-Value.  Analyze transcription regulation works 
similar to analyze network, except the sub-networks created are centered on 
transcriptional factors.   
 
The other two additional “Analyze” network algorithms (transcription factors and 
receptors) focus on the presence of either start-nodes or end-nodes of a certain pathway in 
the submitted list of genes. 
 
The “transcription factors” mechanism favors network construction where the end-nodes 
/ receptor targets of transcriptionally regulated pathways are present in the original gene 
list.  It is irrelevant for this algorithm if the corresponding transcription factors are also 
present in the original gene list or not. 
 
The “receptors” mechanism favors network construction where the end-point of a 
pathway leads to a receptor (through “receptor binding”) and the starting point of a 
pathway (a transcription factor, or ligands, etc…) is present in the original gene list, 
regardless of the presence of the end-point receptor in the list.  
 
The Shortest paths and Self regulations algorithms are similar.  They try to link the 
original genes with additional objects from the database along a directed path.  The 
difference is that the Self regulations algorithm tries to use transcription factors to link 
the objects from the original list.  For both algorithms the maximum number of steps to 
use between your objects can be adjusted in the Advanced Options section. 
 
The Direct interactions algorithm creates a network only from the objects in the original 
list; no other objects from the database will be added.  This algorithm is good to start with 
because it can show if any of the objects in the list “cluster” together by interacting with 
each other. 
 
The Auto expand algorithm adds objects until it creates a fairly dense network; this is 
best used to see the neighboring interactions and objects around a few nodes.  Finally, 
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Expand by one interaction simply adds all the one-step interactions around each node 
from the list. 
 
Advanced options 
 
The Advanced Options section of the Network Options page provides options to specify 
how a network building algorithm builds a network, by specifying how many and what 
types of objects to use, for example. The Advanced Options section can be opened by 
clicking on the Advanced Options header on the Network Options page (Figure 1). You 
can also click on the question mark buttons to see a visual representation for some of the 
options.   
 
There are many options that are common for all the algorithms. These common options 
are described below: 
 
Discard objects - Checking the boxes in this row will restrict the algorithm so that it uses 
only those specified. If the Experiments box is checked the algorithm will only use 
objects from the experiments in the Active Data folder. If the User list box is checked, the 
algorithm will only use the objects selected just prior to opening the Network Options 
page (the objects listed in the Network objects section). 
 
Filter interactions by confidence level - By default MetaCore uses only highly 
confident manually curated interactions in network building. The database does contain 
some low confidence interactions that can be shown or used as specified in this option. If 
the option is set to Use, then the algorithm will use any low confidence interactions to 
add additional objects to the network. If it is set to Show, then the algorithm will not use 
them to add objects, but if both of the low confidence interaction's source and target 
objects are present on the network, then the interaction will be shown. 
 
Use unspecified reactions - An unspecified reaction is an interaction that has both an 
unspecified effect and mechanism. By default these types of interactions are not used. 
They can be shown or used with this option. 
 
Use indirect interactions - Indirect interactions are denoted by the Influence on 
Expression interaction mechanism. By default these types of interactions are discarded. 
With this option you can choose to have the algorithm use them to add additional objects 
to the network, or you can choose to only have them shown. 
 
Use binding interactions (special cases) - By default binding interactions with an 
unspecified effect are discarded in building networks. As with filtering by confidence 
level, you can tell the algorithm to simply show the interactions but not use them or you 
can use unspecified binding interactions. Here also, you can tell the algorithm to treat 
unspecified binding interactions as being bidirectional. 
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There are also some options that are only available with certain algorithms: 
 
Use interaction weights – This option is available for the Analyze network, 
Transcription regulation, Shortest paths, Self regulation, Direct interactions, Expand by 
one interaction, and Auto expand algorithms.  If this box is checked the algorithm will 
take interaction weights into consideration when building the network. Some interaction 
mechanisms have different weights than others. For example, the Complex Relation (CR) 
mechanism has a weight close to 0, while the transcription regulation (TR) mechanism 
has a larger weight. When this option is checked, the weights are used to determine path 
length. For example, if weights are used on the Expand by one interaction algorithm, it is 
possible for the algorithm to add an object two steps out. Because of the weights of those 
two links, they are considered one interaction. 
 
Number of nodes in a fragment – This option is available for the Auto-expand, Analyze 
network, and Transcription regulation.  This value is the number of objects that the 
algorithm will attempt to place into a single cluster of objects. The default value is 50. 
 
Number of steps in the path – This option is available for the Shortest paths and Self 
regulations algorithms.  With this drop-down menu you can set the maximum steps the 
algorithm will use to try and connect the objects from your list. One step is one 
interaction, so if the maximum number of steps is set to two, then there will be at most 
one additional object added between two objects from your list. The default maximum 
value depends on the number of objects in your list. When using one of these algorithms, 
it is always a good idea to make sure the maximum number of steps is not too high, to 
avoid creating very large networks. 
 
Show non-connected root nodes – This option is available for the Shortest paths, Self 
regulations, Direct interactions, Expand by one interaction, and Auto-expand algorithms.  
In some cases the algorithm will not be able to connect a given object to the others from 
your initial list. By default these objects will be shown as unconnected objects on the 
network. With this option, you can choose to have these objects hidden. 
 
Edges weights – This option is available for the Analyze network (transcription factors) 
and Analyze network (receptors) algorithms.  In these algorithms, the interactions are 
assigned weight values.  These values are: 
 - Inside – edges connecting nodes present in the initial gene list  
 - Nearest – edges connecting nodes, only one of which is present in the original 
  gene list  
 - Outside – edges between nodes that do not exist in the original gene list  
 - Forbidden – those edges that lead to numerous receptors or transcription factors.  
 
The default weight values are pre-selected in such way that preferentially builds network 
paths through the start- or end-nodes in such a manner that paths would not contain 
intermediate edges leading to other receptors or transcription factors. Then, the shortest 
paths from receptors to the corresponding transcription factors are found. 
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Add complementary objects - This option is available for the Analyze network 
(transcription factors) and Analyze network (receptors) algorithms.   Complimentary 
objects, receptor ligands or transcription targets, from the initial gene list may be added to 
the resulting networks by checking this box.  

Group networks - This option is available for the Analyze network (transcription factors) 
and Analyze network (receptors) algorithms.  This option will group some of the 
resulting networks together. In the case of the “transcription factors” algorithm, networks 
are grouped by the targets of given transcription factors. In the case of the “receptors” 
algorithm, networks are grouped by different transcription factors leading to the given 
receptors. 

 
Figure 1: 1. Click here to open the Advanced Options panel. 2. Click here to see a visual 
representation of how the algorithm works. 
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Pre-filters 
 
Another option available in network building is the ability to pre-filter a network based 
on tissue, sub-cellular localization, organism, object type, and/or interaction type.  The 
resulting networks then contain only those objects that are known to be expressed in the 
selected tissue or localization; have an ortholog for the selected organism; are of the 
selected object type(s); or are connected by the selected interaction type(s).  To use the 
pre-filters, uncheck the ‘Disabled’ box and click the Select button to choose the pre-filter 
criteria (Figure 2). 
 

 
Figure 2: 1. Click here to open the pre-filter panel. 2. Uncheck the Disabled box and click Select. 3. 
Choose an option and click Select. 
 
Adding more objects 
 
Network objects can be added to the list used in network building from the Network 
Options page.  This feature can be useful if, for example, you are building networks 
around a dataset but wish to add one or more objects not in the dataset to see how the 
additional objects affect the resulting network.   
 
To add objects from the Network Options page, first click the “Network objects” header.  
Then click the “Add network objects” button.  In the window that appears, search for the 
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object you wish to add.  Then check the box next to the desired result and click the Add 
selected object button (Figure 3).  The object will then be added to the list used for 
building networks. 
 

 
Figure 3: 1. Click here to open the network objects section. 2. Click here to add more objects to the 
list. 3. Search for the objects to add. 4. Check the desired results. 5. Click here to add selected objects 
to the list. 
 
Network Manipulation 
 
There are many ways to make a network easier to read.  You can make all the edges 
semi-transparent by checking the “Fade edges” option in the Show menu.  Fading the 
edges will cause the nodes to stand out.  By doing this a complex network will appear 
less “cluttered”.  Effect hexagons on interaction arrows are hidden by default.  They can 
be shown by checking the “Effects” option in the Show menu (Figure 4).   
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Figure 4: 1. Show menu. 2. Edges faded and Effects unchecked. 
 
Another way to make a network less complex is to hide objects.  You can hide all the 
objects without expression data by clicking the “Hide non-expressed” option from the 
Selection sub-menu of the Edit menu.  This will leave only those objects that have 
expression data visible on the network.  Additionally, you can hide selected objects by 
first dragging a box around them or holding CTRL and clicking on them.  Then click the 
“Hide selected objects button” (Figure 5).   
 
Objects and interactions can also be removed from the network.  To do this, right-click 
on the object or interaction hexagon and choose Remove from the context menu (Figure 
5).  When objects are removed they are then not used in generating Process, Disease, or 
Tissue lists.  Removed objects are also no longer displayed in the network statistics page.  
Please note that removed objects cannot be returned to the network in the same manor as 
hidden objects. 
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Figure 5: 1. Option to hide non-expressed objects.  2. Right-click context menu where objects can be 
hidden or removed. 3. Hide selected objects button. 
 
Another way to hide objects is to base your selection on the network filters.  First click 
one of the filter tabs above the network (GO Processes, Diseases, etc.).  Then when the 
list appears, select a category by checking the box next to it.  Then click the “Mark 
selected” button.  All the network objects related to that category will then be circled in 
gray.  Now, click the “Hide unselected objects” button (Figure 6).  The network will now 
only contain those objects that are related to the selected category. 
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Figure 6: 1. GO Processes tab. 2. Choose a process and click Trace selected or Mark selected. 3. Here, 
objects related to selected process are marked. 
 
Hidden objects can be returned to the network either by using the Objects tab or by 
clicking the “Show all hidden objects” button.  Clicking the “Show all hidden objects” 
button will return all the hidden objects to the network.  You can use the Objects tab to 
return individual objects to the network.  In the Objects tab, hidden objects are listed in 
the lower window.  To return an object to the network, select it and click the red up arrow 
button (Figure 7). 
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Figure 7: 1. Select objects to show. 2. Click up arrow to show the selected objects. 3. Click this button 
to show all hidden objects. 
 
Selecting Genes of Interest 
 
Sometimes a large and dense network may be built where it is difficult to find your genes 
of interest.  The quickest way to find your genes of interest is to use the Objects tab.  The 
Objects tab lists all visible network objects in the upper panel and all hidden or grouped 
objects in the lower panel.  To find the object(s) you are looking for on the network select 
it in the upper panel of the Objects tab.  Then you can choose to mark the selected object 
or trace the selected objects.  Tracing the objects will make all unselected objects semi-
transparent and highlight any interactions between the selected objects.  This makes it 
easier to pick out your object(s) of interest (Figure 8). 
 
Additionally, some objects are part of complex groups.  These groups are denoted by a 
yellow star on the object icon.  You can mark or trace the group that your object of 
interest is a part of by selecting it in the lower panel and clicking “Trace object’s groups” 
or “Mark object’s groups” (Figure 8). 
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Figure 8: 1. Selected objects in Objects tab.  2. Objects traced and marked. 3. Objects in groups are 
colored red. 4. Complex groups are marked with a yellow star. 
 
Network post-filters 
 
Another way to see interesting objects is to use the various filter tabs above the network 
image.  Using these tabs you can see the Tissues, the top 12 GO Processes and the top 12 
diseases related to the objects on the network.  You can also filter the network based on 
sub-cellular localization and see which objects have orthology with other species. 
 
The Tissues, GO Processes and Diseases tabs work in a similar manor.  Click the tab to 
see a list of related tissues, GO processes or diseases.  To see which objects on the 
network are related to a result, select the result by checking the box next to it.  Then click 
either the “Mark selected” or “Trace selected” button.  Marking the objects will circle the 
objects related to the process, tissue or disease in gray.  Tracing the objects will make the 
objects not involved in the process, tissue or disease semi-transparent and highlight any 
interactions between objects involved in the process, tissue or disease (Figure 9). 
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Figure 9:  1. Diseases tab.  2. Select a disease and click Trace selected or Mark selected. 3. Here, 
objects in the selected disease are traced. 
 
With the Localizations tab you can hide objects not involved in the selected localization.  
To do so, check the box next to the desired localization and click the “Show selected 
items” button.  Objects not in the selected localization will be hidden (Figure 10). 
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Figure 10: 1. Localizations tab.  2. Select a localization and click “Show selected items” to see objects 
in that localization. 
 
Using the Orthologs tab you can mark the objects that have an ortholog for the selected 
species.  To do so, click the Orthologs tab.  Then check the box next to the desired 
species and click the “Select” button.  The objects with orthologs will be circled in gray 
(Figure 11).  From here you can also click the “Hide unselected objects” button as 
described above to see only the objects with an ortholog in the selected species. 
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Figure 11: 1. Orthologs tab.  2. Check a species and click Select to mark objects. 
 
Pathways tab 
 
The Pathways tab contains the list of all the canonical pathways on the network.  When 
building a network, if the “Use canonical pathways” option was checked in Network 
Options and canonical pathways are present on the network (turquoise colored interaction 
arrows) you can use the Pathways tab to automatically trace the individual canonical 
pathways present on the network.  Click on a pathway to highlight its interactions in 
green.  Clicking the “Animate” button will cycle through all the pathways on the network.  
You can also click the “View source” button to see the map or pre-built network that the 
selected pathway is from (Figure 12).  Alternatively, you can select an object on the 
network and click the “Mark pathways for selected node” button to highlight all the 
pathways on the network that involve the selected object. 
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Figure 12: 1. Selected pathway is highlighted in green.  2. Click here to see the source map or pre-
built network. 
 
Adding Genes of Interest 
 
Additional objects can also be added to an already built network.  This is done by using 
the Add tab.  With this tab, you can search for new objects to add to the network.  To add 
new objects to the network, enter a search term in the Add tab and click Search.  Then in 
the window that appears check the box to the left of the desired result(s).  Then click the 
“Add selected objects” button.  The “Add object” window will then close and the 
network page will refresh with the selected object added to the network.  Objects added 
in this way are connected to the existing network using the shortest paths algorithm. 
 
To expand around objects already on the network, first select the objects by holding 
CTRL and clicking on them.  Then click the “Expand selected nodes” button in the 
toolbar.  In the box that appears there are two expansion options.  You can also choose to 
expand around the chosen object(s) by either the Auto-expand algorithm or by a selected 
number of steps (Figure 13).  After choosing an expansion option, click OK.  The 
network page will then reload. 
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Figure 13: 1. Search for an object to add from the Add tab. 2.  Select the desired object and click 
“Add selected objects”.  3. Pre-existing objects can be expanded by selecting them on the network 
and clicking the “Expand selected nodes” button in the toolbar. 
 
Database information pages 
 
From the network you can see the database information pages for the objects’ associated 
gene, protein, compound, or reaction by clicking on the object itself.  One such example 
of finding this information is to look for the drugs that target objects on a network.  To 
see which objects on a network are drug targets, click the “Select drug targets” button.  
Any drug targets present on the network will then be circled in gray (Figure 14).  At this 
point, to make the network easier to work with, you can also click the “Hide unselected 
objects” button to hide all the object that are not drug targets.  To see more information 
about a drug target, click on it.  The Network object info page will open (Figure 15).  
This page contains many links to more information about the network object; including 
the database information for its associated gene or protein, links to any maps the object 
appears on, links to any corresponding GO processes and diseases, links to known drugs 
for the object and a list of the object’s network interactions.  Click on the “Known drugs 
for this object” header to see the therapeutic and secondary drugs.  After clicking one of 
the drug links, the compound details page will open. 
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Figure 14: 1. Click here to mark drug targets. 2. Drug targets circled in gray. 
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Figure 15: Network objects info page. 
 
The compound details page contains the compound structure which can be downloaded 
as a MOL file by clicking the “Download structure” button.  The details page also lists 
what other genes the drug targets.  This information can tell how specific or broad the 
drug action may be.  From the details page you can also build a network around the 
compound in order to further explore the compounds interactions with other objects 
(Figure 16).   
 
A final tool accessible from the compound details page is the ability search MDL 
DiscoveryGate for the compound.  To do so, first select a search method from the drop-
down menu, then click the “Search in DiscoveryGate” button (Figure 16).  A new 
window will then open with the DiscoveryGate software.  After logging in the search will 
be automatically performed. 
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Figure 16: 1. Click here to download structure MOL file. 2. Select a search method and click here to 
search in DiscoveryGate. 
 
Network Statistics 
 
Various statistics about a network can be seen by clicking the Network Statistics button 
or by choosing Network Statistics from the File menu. This allows you to see a tabular 
overview of the network including information about how the network was built; any 
experimental data on the network; how active different objects are in the network; and the 
GO processes, diseases and tissues related to the network (Figure 17).   
 
The top section of the statistics page displays basic information about the network 
including its name and description (a description can be added by clicking the "Rename" 
button on the network page). Click on a section hyperlink to go directly to that section or 
click a section header to open the information panel. The first section shows what options 
were used when building the network including the algorithm used, any chosen pre-filters 
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and the advanced options used.  All the nodes with experimental data are listed as well. 
The table includes the network object, its related genes, the gene description, and the data 
value (Figure 18). All of the objects on the network are listed in the Hubs and Nodes 
sections. A Hub is a node that has five or more edges on the network.  Two numbers are 
listed in the edges column. The first number is the total number of edges for that node 
and the second number is the number of hidden edges for that node on the network. An 
edge is hidden if one or more of the nodes connected to it is hidden or if the nodes 
connected by the edge are in a group. 
 

 
Figure 17: 1. Click a link to jump to that section. 
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Figure 18: 1. Click the headers to open each section. 2. The Experiments section lists the objects with 
data. A description of the object and the data value are listed as well. 
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Figure 19: 1. Visible edges / Hidden edges are listed for each Node and Hub. 2. Click the “Edges” 
header to sort the table. 
 
Experiment Interactome 
 
Similar to the network statistics for a network, the Interactome feature can show network 
connection information for an uploaded experiment as a whole.  With this feature you can 
see a list of proteins that interact with the proteins from the active experiment. You can 
also obtain a list of how many interaction an object from your list has in total.  To use this 
feature, first activate anexperiment or gene list.  Then select the desired option from the 
“View->Interactome for experiment” sub-menu.  There are four options available, 
described below. 
 
Interactions total 
 
After selecting this option, specify a p-Value threshold in the box that appears.  A p-
Value is calculated for each object in the active experiment based on the number of 
interactions it has.  The threshold set here is used to filter the proteins based on this 
calculated p-Value.   

1

2



Copyright © GeneGo, Inc., 2000-2008 
 

24

After specifying the threshold, a window will open with a table listing the proteins from 
the active experiment on the left and the proteins that they interact with on the left.  If 
both interacting proteins pass the FDR threshold, the row in the table will be colored 
yellow (Figure 20).  The table can be exported to an Excel file by clicking the “Export” 
button in the upper right (Figure 20). 
 

 
Figure 20: 1. Interactions between two genes that pass the FDR threshold are highlighted. 2. Click 
here to export the table as an Excel file. 
 
Interactions by protein class 
 
This tool will generate a table listing the objects from the active experiment and the 
objects that they interact with.  Check the “Show all columns” box to see all the values 
that have been calculated.  The table lists the number of interactions the object has with 
objects in the active experiment (r), the number of network objects in the active 
experiment (n), the total number of network objects that interact with the object (R), and 
the total number of network objects in the database (N).  The objects in each section are 
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ranked by a p-Value representing the probability that the object will have a number of 
interactions greater than or equal to its r value in a network created by a given number of 
objects.  The table also lists the mean value for the hypergeometric distribution.  A z-
score is also calculated for each object.  The z-score is (r – mean) / sqrt(variance) (Figure 
21). 
 
Here again, you can export the information in the table to an Excel file by clicking the 
“Export” button in the upper right (Figure 21). 
 

 
Figure 21: 1. Click here to see all the data columns.  2. Rows with a symbol are from the active 
experiment.  3. Rows without a symbol are objects from the database that interact with objects from 
the active experiment.  4. Click here to export the table as an Excel file. 
 
Transcription factors 
 
This tool functions in a similar manor as the “Interactions by protein class” tool.  
However, this tool only lists transcription factors. 
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Interactome topology 
 
The tool calculates average degree, degree in, degree out, and clustering coefficient for 
the whole database, for the experiment (node calculations based on the whole database 
and averages based on the experiment), and for only the experiment (all calculations 
based only on the experiment).  Similarly, this table can also be exported as an Excel file 
by clicking the “Export” button (Figure 22). 
 

 
Figure 22: 1. Click here to export the table as an Excel file. 
 
Working with Gene Lists 
 
There are many locations throughout MetaCore where gene lists can be exported.  Most 
of the export panels contain various options as well.  To export genes from a map, first 
click the “Export options” header.  Then enter a name for the list.  If you wish to only 
export those genes that have expression data, check the “With expression data only” box.   
Then click the Export button (Figure 23).  Gene lists can also be exported directly to an 
Excel file by choosing the “Excel” option in the “Export to” row of the Export panel. 
 
In addition, genes can be exported to the third-party analysis tools Rosetta Resolver, 
GeneSpring GX, and Spotfire DecisionSite.  To export a gene list to one of these tools, 
select one of the tools in the “Export to” row, give the list a name and click Export 
(Figure 23).  When exporting to Resolver a .broadcast file will be created.  When 
exporting to GeneSpring GX a zip file will be created.  The zip file can then be dragged-

1
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and-dropped into GeneSpring GX.  When exporting to Spotfire a new window will 
appear from which you can either load the list into a running DecisionSite window or 
mark the genes from the map in an already open file in DecisionSite. 
 

 
Figure 23: 1. Enter a name and click Export to save the gene list. 2. Check this box to only export the 
expressed genes. 3. Select a tool to export to. 
 
Gene lists can also be exported from the intersection groups of the Enrichment Analysis 
Workflow and Compare Experiments Workflow tools.  To do so, right-click on the 
intersection bar and choose “Export genes” (Figure 24).  In the box that pops up, give the 
list a name and click OK.  The list will then be saved to the MetaCore Gene lists tool.  
The option to export the genes directly to an Excel file is also available from the right-
click menu. 
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Figure 24: 1. Right-click on an intersection group to export the genes in that group. 
 
Gene lists can also be exported from a network.  Click the “Export lists of objects from 
network” header to open the export panel.  There are multiple options for exporting 
genes.  Not only can you choose to export all genes or only expressed genes; but you can 
also export only root nodes (those objects used to initially build the network), selected 
nodes, and visible nodes.  The additional options are accessible after checking the 
“Advanced mode” box.  For example, to export only the visible selected nodes with 
expression data, choose “Selected nodes” in the “Which nodes” drop-down menu, check 
the “Only visible nodes” box, check the “With expression data only box”, give the list a 
name and click Export (Figure 25). 
 
Gene lists can also be exported to an Excel file or to the third-party tools Rosetta 
Resolver, GeneSpring GX and Spotfire DecisionSite from networks by selecting the 
desired option in the “Export to” row and clicking the Export button. 
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Figure 25: 1. Choose Genes. 2. Check this box to export only expressed genes. 3. Choose to export All, 
Root, or Selected nodes here. 4. Give the list a name and click Export to save the list. 5. Genes can be 
exported to third-part tools here. 
 
Logical operations 
 
The Logical Operations tool can be used to combine and compare gene lists.  The tool is 
accessible from the Tools menu of the Data Manager.  In the first step of using the tool 
select the gene lists you wish to work with from the left window and click the “>>” 
button to move them to the right window.  Then click Next (Figure 26). 
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Figure 26: 1. Select lists in the left window. 2. Click here to move them to the right. 3. Click Next. 4. 
Additionally, you can click the “Build network” button to build a network from the two selected lists 
without having to combine them into one. 
 
In Step 2, choose the operation to use.  The operations are Union (combine multiple lists 
into one), Intersection (create a list of all common genes), Exclusive OR (create a list of 
genes in one list, but not two), Left difference (subtract the genes in subsequent lists from 
the first list), List difference (create a list of the Union minus the Intersection), and Right 
difference (similar to Left difference except that the subtraction starts with the final list 
instead of the second).  You can also create a list based on how many lists a gene appears 
in using the Index section.  For example, if you chose four lists and want to see how 
many genes appear in three or more of them, select the “>=” option and choose ‘3’ in the 
Index box.  After making your choice, click Next (Figure 27). 
 
In step 3, give the list a name and click “Create list”.  This new list will then be added to 
the Gene Lists tool. 
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Figure 27: 1. Select an operation. 2. Click Next. 
 
Saving Networks and Images 
 
Networks can be saved in two formats, Networks and Netshots.  Netshots retain the 
network exactly as it is with any expression data mapped.  Saved Networks, however, do 
not retain the expression data and will reflect any subsequent changes to the objects or 
interactions on the network as the MetaCore database is updated.  So, if you save a 
network as both a Network and a Netshot you can see exactly how it looked when it was 
created (with the Netshot) and how it may have changed with subsequent MetaCore 
updates (with the Network).  To save a network, choose “Save” or “Save as” from the 
File menu.  Then, in the window that appears, enter a name and optional description; 
choose whether to save it as a Network or a Netshot; and then click “Save”.  From this 
window you can also choose to retain or discard any hidden objects by checking or 
unchecking the “Save hidden nodes and edges” box (Figure 28). 
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Figure 28: 1.  Click here to save the network. 2. Choose Network or Netshot here. 3. Enter a name 
and optional description. 4. Choose to save or discard hidden objects here. 
 
High quality images (300dpi) of networks and maps can be saved as well.  To save an 
image of a network choose the “Export image” option from the file menu.  In the box that 
appears, choose a resolution and click OK (Figure 29).  Then browse for a location on 
your computer to save the file.  The image file type is PNG. 
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Figure 29: 1. Click here to export an image file. 2. Choose a resolution and click OK. 
 
An image of a map with data thermometers can also be exported to a PNG file. To do so, 
click the “Export to image” button.  In the window that appears, select a resolution and 
click OK (Figure 30).  Then browse for a location on your computer to save the file. 
 

1

2



Copyright © GeneGo, Inc., 2000-2008 
 

34

 
Figure 30: 1. Click here to save an image of the map with data thermometers. 2. Choose a resolution 
and click OK. 
 
Data Sharing 
 
With the Data Manager, you can share experiments, gene lists, and saved networks with 
other users or groups. There are two ways to access the share tool. You can either click 
Share from the File menu after selecting an experiment by Left-Clicking on it, or you can 
Right-Click on an experiment and select Share in the context menu.  The window that 
comes up will display some information about the experiment and a field to search for 
users to share it with. Enter a username in the search field and click Search. Select a user 
in the results field and click “Add selected to list”. The user will appear in the “Shared 
with” section (Figure 31). 
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There are six share levels available. The most permissive level is on the left and the least 
permissive level is on the right. The different levels are: 
 

Allow 
- OW - Owner Rights. This level will allow the user it is shared with to 

share it to others and to delete it. 
- WA - Write Access. This level will allow the user it is shared with to 

rename it and to overwrite it. 
- RA - Read Access. This level will only allow the user it is shared with 

to view the experiment(s) and related maps, networks, etc. 
Deny 

- OW - Owner Rights. Choose this level if you have, for example, 
allowed ownership rights to an entire folder, but would like to deny 
ownership right to some individual experiments within the shared 
folder. 

- WA - Write Access. Choose this level to deny write access to 
individual experiments with a shared folder. 

- RA - Read Access. Choose this level to totally restrict all access to a 
file within a shared folder. 

 
Additionally, if you wish to completely give up your ownership of a file to another user, 
first select to Allow Owner Rights (OW) of the file to the other user and then check the 
box next to "Refuse from ownership" and click OK. You will then no longer have 
ownership rights to the file. 
 
Experiments you own that are shared with other users will be marked with a blue hand 
icon in the Data Manager ( ). Experiments owned by another user that are shared with 
you, can be found in the Shared Data folder and they will be marked with a green hand 
icon ( ). 
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Figure 31: 1. Search for the user to share with here. 2. Select a user and click “Add selected to list”. 3. 
Set the sharing level and click OK. 
 
 
In addition to sharing experiments, you can download the original uploaded file by right-
clicking on the experiment in the Data Manager and choosing “Download file”.  You can 
also export the experiment to Excel by choosing the “Export to Excel” option from the 
right-click menu (Figure 32).  This option will create an Excel file containing the gene 
symbols and names for all the recognized genes, along with the uploaded expression data. 
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Figure 32: 1. Right-click on the experiment to download the original uploaded file (“Download file”) 
or to “Export to Excel”. 2. This “Export genes” option will create a gene list within MetaCore 
containing the genes in the experiment. 
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